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In Windows, you can use Windows Firewall to block or unblock certain
applications, but it doesn't offer an easy-to-use interface for its
advanced features. If you want to block an application from accessing
the internet, you must go through the following steps:

1. Click the Windows Start Menu and open Control Panel

2. Select System & Security

3. Then in the Firewall section, you select “Allow a program through the

Windows Firewall”

4. If the program you wish to block or unblock isn't listed, you must click
“Allow another program” to add it. Choose the application in the list and
select “Add". Else you must then browse the hard drive to find it, and so

on. This seems complicated for the average user.

Firewall App Blocker makes the process very easy! Simply drag and drop
the application you wish to block into the FAB window, or browse the
hard disk to find it.That's it!

What is new: (Wednesday, 28 September 2022)

[FIXED] - If you change GUI language, Enable WhiteList box disappears
[FIXED] - A minor bug in command prompt
[FIXED] - Entries can't be sorted that the most recently added ones are

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/
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at the top Our Software
[ADDED] - Partial language support for “File -> Netsh Commands”

** Firewall App Blocker v1.9

File Edit Firewall Options Help

YOLPBO YOV S i

Enabled Action Location

a @ CCleaner Yes Block  D:\hepsi\programlar\0\Ccleaner5.92...
a @ CCleanerReactivator Yes Block  D:\hepsi\programlar\0\Ccleaners.92...
a ® Camtasia Recorder 2021 Yes Block  C:\Program Files\TechSmith\Camtasi...
[ -] ® crashpad_handler Yes Block  C:\Program Files\TechSmith\Camtasi...
a ® Camtasia 2021 Yes Block  C:\Program Files\TechSmith\Camtasi...
] @ Camtasia 2021 Recorder Yes Block  C:\Program Files\TechSmith\Camtasi...
(] @ EmEditor Yes Block G:\EmEditor\EmEditor.exs

a @ Beyond Compare Yes Block D:\hepsi\programlar\0\Compare\Bey...

| B8 outbound Rules B2 Inbound Rulesl Enable WhiteList [

If you want to allow it access again, just right clik on it and choose
“Allow” or select it and press the Delete button also you can use Allow
button.
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File Edit Firewall Options Help

LA A A A A A =

a @ CCleaner Yes Block D:\hepsi\programlar\,0\Ccleaner!5.92\x64,CCl
/] ® CCleanerReactivator Block D:\hepsi\programlar,0YCcleaner',5.92'x64\CCl

Yes
e l'— “\Program Files\TechSmith\Camtasia 2021\L

Enable
B ca i Block C:\Program Files\TechSmith\Camtasia 2021\c
Disabl
8o c it Block C:\Program Files\TechSmith\Camtasia 2021\
a @ Cal Allow Black C:\Program Files\TechSmith\Camtasia 2021'J
a ® Em Block Block G:\EmEditor\EmEditor.exe
] @ Bey Black D:\hepsi\programlar0yCompare\BeyondComp|
Paste Ctrl+Y
Delete Del
Rename F2
Copy Path Ctrl+C
I &S Outbe Select Al Cirl+A Ecbla Wikt et ]
Invert Selection
All ... >
Run The App
Open Location
File Properties
Refresh F3

In this version there are some extra features on the Firewall menu,
including “White List Mode”, Block internet, Restrict Firewall Options
etc.

What is WhiteList Mode: it will block everything except on the white
listed items, to activate it tick the “Enable WhiteList” box on the right
bottom corner, The whitelist mode denies access to all network

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/ 2111
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interfaces, After enabling WhiteList Mode Drag and drop an
Application/Applications on the “Firewall Application Blocker” interface

to Allow it/them , It was the most wanted feature

<" Firewall App Blocker v1.9

File Edit Firewall Options Help

Default Mode a : & = r@
| ) S ==
Whitelist Mode -‘/ \*/ $ \‘&‘/ el
T Action Location
Disable Firewall Block D:\hepsi\programlar\,0\Ccleaner}5.92\x644CCl
Block D:\hepsi\programlar,04Ccleaner',5.92'x64\CCl
Reset Firewall Settings C:\Program Files\TechSmith\Camtasia 2021\L|
Restart Firewall Service Block C:\Program Files\TechSmith\Camtasia 2021\c
Firsinall Setiings Block C:\Program Files\TechSmith\Camtasia 2021\J
N Block C:\Program Files\TechSmith\Camtasia 2021\C
Restrict Firewall Access
B8O emi..... i Block G:\EmEditor\EmEditor.exe
a @ Beyond Compare Yes Block D:\hepsi\programlar0yCompare\BeyondComp|
| % outbound Rules B2 Inbound Rules | Enable WhiteList ]

Following command can be used to allow WhatsApp in whitelist. You
can use this command with task scheduler or in a script.

fab_x64.exe /a /allow /in /out
%ProgramFiles%\WindowsApps\*WhatsAppDesktop*

If you want to delete old whatsApp, you need to run below command,
before the above add command

fab_x64.exe /d /in /out
%ProgramFiles%\WindowsApps\*WhatsAppDesktop?*

Note: When you enable the WhiteList mode, some devices such as a
printer on your local network may not work properly, to solve this
Problem,you can allow devices on your local network by clicking File -
Netsh Commands - Allow Local Subnet

<" Firewall App Blocker v1.9

File Edit Firewall Options Help
Add Application = r : & =
Y@ ¥ & =%
Add Folder Contents A \-/ ¢ b4 -
Add Process Enabled  Action  Location
Rt it Yes Black D:\hepsi\programlar0\Ccleaner\3.92\x64\CCl..
By Yes Block D:\hepsi\programlar\0\Ccleaner\5.92\x64\CCl..
Lo k
i Yes Block C:\Program Files\TechSmith\Camtasia 2021%L.
Metsh Commands » Impart Firewall Config les\TechSmith\Camtasia 2021\c.
- Export Firewall Config les\TechSmith\Camtasia 2021\C.
- G U b Netsh Sample Rule les\TechSmith\Camtasia 2021\C.
a ® EmEditor mEditor.exe
Metsh 5ample Rule - Del
a8 @ Beyond Compare -amlari0\Compare'\BeyondComp.
| Aow Local Subnet |
Allow Local Subnet - Del
| % outbound Rules B2 Inbound Rulesl Enable WhiteList ]
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To sort Entries that the most recently added ones are at the top , please
click enabled or action column header first then “#” column will
appear, click on header this column to sort the most recently added
entries at the first place.

o Firewall App Blocker v1.9

File Edit Firewall Options Help

: S = — : : . ==
POFT YU YOV & =
MName Engb... Action Location #
[ ] @ Camtasia 2021 Recorder  Yes Block C:\Program Files\TechSmith\Camtasia 2... o ':
a ® Camtasia 2021 Yes Block C:\Program Files\TechSmith\Camtasia Zﬂ
ﬂ@ crashpad_handler Yes Block C:\Program Files\TechSmith\Camtasia 2...
a2 ® Camtasia Recorder 2021 Yes Block C:\Program Files\TechSmith\Camtasia 2...
] ® CCleaner Yes Block D:\hepsi\programlar\0hCcleaner}5.92\x6...
a ® CCleanerReactivator Yes Block D:\hepsi\programlar\0\Ccleaner!3.92\x6...
a ® Beyond Compare Yes Black D:\hepsi\programlar\0Compare\Beyond...
/] @ EmEditor Yes Block G:\EmEditor\EmEditor.exe
I K outbound Rules &3 Inbound Rules' Enable WhiteList ]

How to Block Ms EDGE internet connection Properly: To block
Microsoft EDGE properly please use “Disable_EdgeRule.bat” Here and
then use FAB (Firewall Application Blocker) Add Process button (second)
to add Microsoft EDGE icons on the FAB interface.

To add an Outbound or Inbound Firewall Rules separately, use One of
the Bottom left buttons, shown above are Firewall Application Blocker
file and Options menus

o Firewall App Blocker v1.9

File Edit Firewall Options Help

,:G: > Always On Top b 17

k 'l \E \ F A - =
b \?;/ v Show Outbound Rules on Startup 4 - 6
Mame ~  Show Status Indicator

a ® CCleaner rogramlari0\Ccleaner\5.92\x64\CCl..

Show Grid Lines on List
Change the List Font

8 Q) cCleanerrea
B © Camtasia Re:
] ® crashpad_ha Add To Exe Context Menu
'@ Camtasia 20 Use the Shift Key to Displa
B8O camtasia 20:
a @ EmEditor

ﬂ@ Beyond Comj

rogramlari0\Ccleaner\s.92\xa4\CCl..
m Files\TechSmith\Camtasia 2021\L.
m Files\TechSmith\Camtasia 2021\c.
m Files\TechSmith\Camtasia 2021\C.
1 Files\TechSmith\Camtasia 2021\C.
or\EmEditor.exe

Show Hidden Files

+~  Show File Extensions
rogramlari0\Compare'BeyondComp.

Languages >

Enable WhiteList ]

|l§ Outbound Rules B Tnbound Rulesl

By selecting Options -> Languages -> Translate, you can easily translate
FAB into your language. By choosing “Add Process” feature you can Add
any process to Outbound or Inbound list. To add more than one
process, just hold down the ctrl key and select the Processes

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/
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Dns jumper - 4.737.699

Windows Update Blocker -
2.729.871

Firewall App Blocker -
1.211.990

Reduce Memory - 1.044.974
Easy Context Menu - 713.264

Easy Service Optimizer -
524.856

Edge Blocker - 468.015 New
Folder Painter - 404.481

Win11 Classic Context ... -
310.865

Relcon - 307.748

BlueLife Hosts Editor - 298.801
Ratool - 281.880

DNS Angel - 247.822
RunAsTool - 242.741
AskAdmin - 230.828

Qemu Simple Boot - 225.820
WebCam On-Off - 222.735
PowerRun - 203.391

Ntfs Drive Protection - 196.678
BluelLife KeyFreeze - 187.991

Bluetooth Version Finder -
185.188

Show Disk Partition Style -
173.339

Router Default Passwords -
163.209

Fix Print Spooler - 162.539

Window TopMost Control -
146.303

Reg Converter - 128.087

Temp Cleaner - 120.141
Simple Run Blocker - 113.120
Net Disabler - 110.856

Drive Letter Changer - 104.607
6to4 Remover - 103.422
Simple VHD Manager - 90.731

Hide From Uninstall List -
101.114

Defender Exclusion Tool -
97.443

lInAdate Tima - 72 OR1
4/11
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Rebuild Shell Icon Cache -
75.835

SendTo Menu Editor - 68.267
Registry Key Jumper - 67.017
Password Generator - 63.609

Backup Start Menu Layout -
63.200

Dns Lock - 63.121

Hibernate Enable or Disable -
62.295

Restart Explorer - 61.136
Safe Mode Launcher - 54.939

Windows Settings Blocker -
52.480

Switch Power Scheme - 50.399
URL Disabler - 46.396

Network Profile Changer -
45.880

Sordum Monitor Off - 44.902
Simple Firefox Backup - 44.196
Copy Public IP - 39.650

Classic Shut Down - 37.178
Reset Data Usage - 36.597
Desktop.ini Editor - 36.440
Show Desktop Icons - 35.563
Bpuzzle - 32.557

VHD For Context Menu -
28.042

Find Prime Numbers - 25.412
Streams Remover - 24.672

Mouse Settings Changer -
23.865

Send Windows Key - 22.091

No Mouse Wheel Zoom -
15.923

Store Apps Tool - 9.159
Skip UAC Prompt - 8.825 New
Wi-Fi Filter Tool - 7.066
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Robert Childer ... | Windows
Updat ...

Sordum Team | Windows
Update Block ...

Sordum Team | Skip UAC
Prompt v1.2

Fatih | Windows Update Blocker
vi. ..

Tony4219 | Skip UAC Prompt
v1.2
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< Firewall App Blocker v1.9

File Edit

Firewall Options

Add Application
Add Folder Contents

Help

e ¥e

[ Add Process

Import List
Export List

Exit

B &) EmEditor
B ) Beyond Compare

T e ek F T

Mame
- ;ﬂﬁ WmiPrvSE.exe
CEPHtmIEngine.exe
@ Adobe Spaces Helper.exe
5 AdobelPCBroker.exe
B rhotoshop.exe
) Fab_xo4.exe
€ chrome.exe
& WmiPrvSE.exe
audiodg.exe
= msedgewebview?.exe
LineCall.exe

Metsh Commands b

] EnabI\éd Action
Yes Block
Yes Block

Yes Block
Yes Block
Yes Block
Yes Block
Yes Black

& Firewall App Blocker v1.9 - Processes

User

METWORK SER...
velociraptor
velaciraptor
velociraptor
velaciraptor
velociraptor
velociraptor
NETWORK SER...
Local Service
velociraptor
wvelociraotor

Firewall App Blocker (Fab) v1.9

4 ! p’h | il
- Al =4
Location

D:\hepsi\programlar\0\Ccleaner',5.92\x644CCl
D:\hepsi\programlar,0YCcleaner',5.92'x64\CCl

C:A\Program Files\TechSmith\Camtasia 2021\L

C:\Program Files\TechSmith\Camtasia 2021\c
C:\Program Files\TechSmith\Camtasia 20211\
C:\Program Files\TechSmith\Camtasia 20214
G:\EmEditor\EmEditor.exe

D:\hepsi\programlar0yCompare\BeyondComp|

Location
C:\Windows\system32\wbem\wmiprvse.exe
C:\Program Files\Adobe\Adobe Photoshop Ct
C:\Program Files\Adobe\Adobe Photoshop Ct
C:\Program Files (x86)\Common Files\Adobe
C:\Program Files\Adobe\Adobe Photoshop Ct
C:\Users\velociraptor\Desktopifab_v1.8\Fab_
C:\Program Files\Google\Chrome\Application
C:\Windows\sysWOWe4\whem\wmiprvse.ex
C:\Windows\system32\AUDIODG.EXE
C:\Program Files (xB86)\Microsoft\EdgeWebVi
C:\Users\velociraptor\AppData\Local\LINE\Dz

Add selected items to the List

When “Add to exe context menu” feature enabled from Options menu,

you will be able to block/unblock a specific app right from Windows
Explorer right-click context menu, this will allow you to right click any
.exe file and easily add it to the Windows Firewall. This context menu

entry can be altered to only display when you press the Shift key. To do

this, select “Use Shift Key to Display”

Create shortcut

Delete

Rename

Properties

## Firewsll App Blocker

*  §? Block In Windows Firewall

& Remove From Windows Firewall

" ) Launch Firewall App Blocker

FAB also offers CMD support. To use this, just make sure to use the

correct parameter, as shown below:

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/

= Sordum Team | Ratool v1.4
(Removab ...

= flavio | Ratool v1.4 (Removable
Ac ...

= Sordum Team | Hibernate
Enable or ...

= zhouyuntian | Hibernate Enable
or..

= The Fanihi Man | Windows
Update BI ...

= Sordum Team | PowerRun v1.6
(Runw ...

= GBR | PowerRun v1.6 (Run with
high ...

= Desp Alk | Windows Update
Blocker ...

= beauty | Dns Jumper v2.3

= Sordum Team | Skip UAC
Prompt v1.2

= Hash Tool

= Random Password Generator
= Convert Case

= Base64 Decoder/Encoder

= HTML Entity Decoder/Encoder
= URL Decoder/Encoder

= Data Size Converter

ZiZ Show My IP Address
B Google Translate

86 User online
63 queries in 0.065 seconds.
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Administrator: C\Windows\system32\cmd.exe

Usage: <command > [<additional commands =]

Commands:

/A Add a firewall rule

Fis] Delete previously added firewall rule
[Out Outbound Rules { Default )

fIn Inbound Rules

[Blodk  Add block rule { Default )
fallow  Add allow rule

[ER Enable rule

JOR. Disable rule

Fid Import firewall rules from an exported Config file
a Windows firewall options { 0=Default, 1=White list, 2=Internet block, 3=Disable firewall )
Examples:

Fab_x64.exe (A C:\Exampledpp.exe
Fab_x64.exe (A [In fAllow C:\ExampleApp.exe
Fab_x64.exe fA [Out /In C:\ExampleApp.exe
Fab_x64.exe A [Out /In Block C:\MyFolder

Fab_x64.exe /D C:\Exampledpp.exe
Fab_x64.exe /D [In C:\ExampleApp.exe

Fab_x64.exe /D [Out /In C:\ExampleApp.exe
Fab_x64.exe /D [Out /In C:YMyFolder

Fab_x64.exe /1 C:\Import.ini

Fab_x64.exe [ER TargetRuleMame
Fab_x64.exe /DR TargetRulelame

Fab_xf4.exe /00
Fab_x64.exe /O 1
Fab_x64.exe /O 2
Fab_xt4.exe /O 3

Note: Firewall App Blocker doesn’t change Windows Firewall default
Rules. If you use 3rd party security software or a 3rd party firewall (e.g.
Avast), they can disable your Windows Firewall. If you do not want Ms
Edge and similar microsoft programs to access the Internet in White List
mode, you can manually disable their rules in the advanced windows
firewall settings Firewall App Blocker runs properly only if your Windows
Firewall is enabled.

Supported Operating Systems: Windows 11, Windows 10, Windows
8.1, Windows 8, Windows 7 , Windows Vista - (both x86 and x64)

Supported languages: English , Turkish , German, French , Brazilian
portuguese , Greek, Italian, Polish, Persian, Russian, Dutch, Spanish,
Korean, Simplified and Traditional Chinese , Indonesian , Japanese,
Finnish , Hungarian , Ukrainian, Slovenian, Arabic, Vietnamese,
Bosnian, Czech, Hebrew , Thai, Portuguese , Romanian, Swedish

A o P "
P EDITORS
% CHOICE

'.;-:l A

File: Fab_x64.exe | Virustotal
MD5: 970b29465d8118bf8038a42c92bfo0df
SHA1: b22d955115f4142198a288550d3592927b1b9460

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/ 8/11
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File: Fab.exe | Virustotal

MD5: 5da9c7ba1250ae64f2ae50f1244dc5e9

Firewall App Blocker (Fab) v1.9

SHA1: d11b74adf1ad35dd6df0f57004e287859f021a29

Download
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’EW - REG CONVERTER V1.2

82 Comments |

5 & Jan 22,2018
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¥ STORE APPS TOOL V1.1
18 Comments | Sep 1, 2023

Sordum Team | April 21, 2024

Hi, We have noted down your request . You can use
netsh.exe to backup and restore all firewall rules.

To back up firewall rules;
netsh.exe advfirewall export C:\fw-rules.wfw

To restore firewall rules;
netsh.exe advfirewall import C:\fw-rules.wfw

If there is a space in the file location, enclose the file
location in quotation marks.

v.a.p. | April 21, 2024

Good afternoon Sordum Team

A question please, there is an option on the command
line to import the FAB program rules, but what is the
option to EXPORT the FAB program rules, or the

https://www.sordum.org/8125/firewall-app-blocker-fab-v1-9/
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command line option to export the FIREWALL rules?
THANK YOU.
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